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3-D Chart 
3-D charts are any charts that have a three-dimensional appearance, 

that is, height, width, and depth. 

Action Buttons 

Action buttons are buttons that you create in a presentation that 

perform an action when you click them. You can have an action button 

start a video, give information, play a sound, or move to a hyperlink. 

Animation Effects 

Animation effects are builds, movement, and other special effects 

that can be applied to objects and text to add interest and variety to 

a presentation. 

Animations 
Animations are effects that allow you to reveal the points on a slide 

one by one. 
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Application Window 

The PowerPoint application window holds the current presentation. It 

consists of the default toolbars, but many of the tools and menu 

items are not available if a presentation is not open. 

Audience Handouts 

Audience handouts are small, printed versions of your slides that can 

contain an area for notes. They are usually printed and distributed to 

the audience. 

AutoClipArt 

Use the AutoClipArt command to begin a concept keyword search of 

your slideshow. PowerPoint searches your slideshow for keywords that 

relate to the keywords associated with clip art images in the Clip 

Gallery. 

AutoContent Wizard 

The AutoContent Wizard guides you through a number of formatting 

selections that will help you develop a clear, professional style for 

your presentation. 

Auto Layouts 
Auto Layouts are slide layouts that have ready-made placeholders for 

titles, text, and objects such as clip art, graphs, and charts. 
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AutoShapes 

AutoShapes are the shapes that are drawn automatically when you 

click the button representing the shape and drag the drawing tool to 

the desired size. 

Background 

The Background dialogue box provides various options that let you 

change the background look of a single slide or every slide in the 

presentation. 

Background Fill 

The Background fill options, located in the Background dialog box, 

allow you to change the colour, shading, pattern, texture, and picture 

of slide backgrounds. 

Background Items 

Background items are any objects that are added to the Slide Master 

that appear on all of the slides in a presentation that follow the Slide 

Master’s formatting. Any object on the master, other than the 

master title and text, is considered to be a background item, including 

art, logos, the date and time, slide numbers, and the presentation 

name. 
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Bar Chart 
Bar charts show individual figures at a specific time or show a 

comparison between items. 

Basic Shapes 

Basic shapes are shapes that can be created by simply clicking the 

appropriate Drawing tool, then clicking and dragging it to form that 

shape. 

Blank Presentation 

The Blank Presentation option opens PowerPoint’s default presentation. 

You can design or save any presentation as the default so that 

presentation will open every time you select the Blank Presentation 

option. 

Bring Forward 
The Bring Forward option on the Order submenu allows you to send 

objects forward one level or layer of a slide at a time. 

Bring To Front 
The Bring to Front option on the Order submenu allows you to send 

objects all the way to the front or top level or layer of a slide. 
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Build 
A build is a feature that is formed when bullets or objects appear one 

at a time with animated effects. 

Bullets 
Bullets are dots, arrows, or other symbols used to identify items in a 

list. 

Case 

Case determines whether letters are capital (uppercase) or non-capital 

(lowercase.) This option allows you to change the case of a selected 

letter, letters, or text. 

Chart 
A chart is a diagram of relationships or comparisons between two or 

more things. 

Clip Art 
Clip art is a collection of professionally designed images that can be 

inserted into a presentation. 

Clip Art Categories 
Clip art categories in the ClipArt Gallery are topics that group similar 

types of clip art. 
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Close 
Use the Close command to exit an active presentation without leaving 

the application. 

Common Tasks Toolbar 

The Common Tasks toolbar appears as a floating toolbar on the 

PowerPoint screen. It consists of options that allow you to quickly 

access commonly used dialog boxes, and these options change 

depending on your current process. 

Crop Tool 
The Crop tool allows you to alter an object by hiding or cutting 

portions of it. 

Data 
Data is related information that is grouped and manipulated by an 

application. 

Drag-and-drop 

Drag-and-drop is clicking the mouse button and holding it on a 

selected item, then dragging the item to a new location and releasing 

the mouse button. 
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Drag-select 

Use drag-select to select text. With the I-beam mouse pointer, click 

before the text you want to select, and drag to the end of the text 

you want to select. The selected text appears highlighted (with a dark 

background) and is ready to be changed. 

Drawing Toolbar 

The Drawing toolbar is located on the left side of the PowerPoint 

window and contains buttons that provide quick access to commonly 

used drawing tools and functions. 

Drawing Tools 
Drawing tools include AutoShapes, lines, and other options that make 

it easy to draw, colour, or position presentation objects. 

Elapsed Time 
The elapsed time for the slides that have been rehearsed is displayed 

on the left side of the Rehearsal Timer. 

Exit 
Use the Exit command to close all active presentations as well as the 

application. 
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Fill Effects 

Select Fill Effects in the Background fill section of the Background 

dialog box to choose from a variety of effects, including textures and 

patterns. 

Find 
The Find option allows you to locate every instance of a specified 

word or words. 

Floating Toolbar 

A floating toolbar is any toolbar that appears as a box in the working 

screen area. Any toolbar can be made into a floating toolbar by simply 

clicking-and-dragging the toolbar to the working screen area. 

Font Embedding 
Font embedding saves TrueType fonts in a presentation so text will be 

properly displayed on other computers. 

Font Size 

A font size is the size of a font measured in points. The more points 

there are in a font, the larger it will appear. There are 72 points to 

an inch. 
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Footer 

A footer is any information located in the bottom margin of a 

document that is repeated on every page or every other page, such as 

page numbers or file names. 

Formatting Toolbar 

The Formatting toolbar is located beneath the Standard toolbar and 

contains buttons that provide quick access to commonly used 

formatting tools and options for the application. 

Graphical Builds 
A graphical build is a series of objects that are placed on a slide one 

at a time to create an animated effect. 

Graphics Graphics are images such as clip art, word art, graphs, and charts. 

Handouts 
Handouts are smaller versions of your slides that are printed and can 

be distributed to the audience. 
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Header 

A header is any information located in the top margin of a document 

that is repeated on every page or every other page, such as document 

titles or the date. 

Line Chart 
Line charts show trends or changes in data over a period of time and 

at even intervals. 

Master Text 

The Master text (Object Area for Auto Layouts) is the placeholder 

that contains the formatting for the main text on the Slide Master. 

This placeholder contains the font, colour, size, line spacing, and 

alignment settings of the main text as well as the text’s attributes, 

shape, and placement. 

Master Title 

The Master title (Title Area for Auto Layouts) is the placeholder that 

holds the formatting for the titles on a Slide Master. This 

placeholder contains the font, colour, size, alignment, and line spacing 

settings of the slides titles as well as the text’s attributes, shape, 

and placement. 
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Microsoft Clip Gallery 

The Microsoft Clip Gallery is a supplemental application that gives you 

access to clip art, pictures, sounds, and video clips. Most of the clip 

art, pictures, sounds, and video clips are located on a CD-ROM, and 

can be imported from the Clip Gallery dialog box. The Clip Gallery 

helps you organize and find the clip art and other elements easily. 

Mouse Pointer 

The mouse pointer is the arrow that shows up on the screen and is 

directed by the mouse. The mouse pointer often changes appearance 

depending on where it is positioned or what action you are taking. 

New 

Use the New command to create a new presentation. The New 

command allows you to create a presentation from scratch, or it 

offers a variety of designs and formats that can be used as a 

starting point. 

Notes Pages 
Notes Pages contain a reduced image of a slide as well as an area to 

include speakers notes. 
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Office Assistant 
The Office Assistant appears on all PowerPoint screens until you close 

it and can be used to get help and tips on using PowerPoint. 

Online Presentation 
An online presentation is an electronic slide show that is run on or 

projected from a computer. 

Options 

Options on the Tools menu allows you to set your preferences for 

PowerPoint functions, such as the maximum number of undos, smart 

quotes, and viewing non-printing characters. 

Pen Tool Use the pen tool to mark on the slides during a presentation. 

Picture 
Pictures can be anything from scanned photographs to line art images 

to artwork from compact discs. 

Picture Toolbar 

Use the Picture toolbar to quickly make changes to the selected 

image. The Picture toolbar appears as a floating toolbar whenever you 

have an image selected. 
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Pie Chart Pie charts show the proportions of parts to a whole. 

Placeholders 
Placeholders are predefined areas on Master slides and Auto Layouts 

that designate where specific objects or text should be placed. 

Placement Line 
The placement line appears in Outline view as you drag a slide icon to 

a new location. The line is used to make placement easier. 

Presentation 

A presentation is a collection of slides, handouts, speaker’s notes, and 

an outline, all combined into a file that can be printed onto 

transparencies or projected from a computer. 

Presentation Designs 

The Presentation Designs card in the New Presentation dialog box is a 

collection of templates that helps you determine the colour scheme, 

fonts, and other design features of your presentation. 
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Presentation Templates File 

A Presentation Templates file is any presentation background that is 

saved as a template. You can modify existing templates or create new 

templates from scratch, then save them as a Presentation Template. 

Preset Animations 
Use PowerPoint’s preset animation effects to quickly apply interesting 

animation effects to your slide show. 

Print Range 
The Print Range option in the Print dialog box allows you to specify 

what pages of a document you want to print. 

Regular Shapes 

Regular shapes refer to perfectly proportioned shapes, such as circles 

and squares, that can be inscribed within a square, or any shape with 

equal sides or equal distance from the centre. 

Rehearsal Timer 
The Rehearsal Timer allows you to set timings for your slides so you 

can run the presentation on its own. 
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Replace 
Use Replace on the Edit menu to search for and replace specified 

text. 

Resize Handles 

Resize handles are small, solid boxes that appear in the border of a 

selected object. The resize handles are used to change the size of 

the selected object. 

Ruler Guides 
The ruler guides are the lines on the ruler that move according to the 

pointer position. These lines help position the location of the pointer. 

Rulers Use rulers to help align and size objects on your slide. 

Select 
In order to work with an object, you must first select or activate it. 

One way to select an object by clicking it once with the mouse. 

Selection Box A selection box appears around a text box when it is selected on a 

PowerPoint slide. It includes the selection handles. It also appears 
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around items as you click-and-drag the mouse pointer around a group 

of objects you want to select. 

Selection Handles 

Selection handles, which look like small squares, appear on objects 

when they are selected on a PowerPoint slide. They can be used to 

change the size of the object. 

Send Backward 
The Send Backward option on the Order submenu allows you to send 

objects back one level or layer of a slide at a time. 

Send To Back 
The Send to Back option on the Order submenu allows you to send 

objects all the way to the back level or layer of a slide. 

Shade Styles 

Shading an object in PowerPoint creates a gradient effect — a gradual 

shift from one colour to another. All objects in PowerPoint can be 

filled with a shaded colour. 
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Shading 
Shading is a modification of a colour that is made by adding 

complementary colours or small amounts of black. 

Shading Fill Shading Fill sets the overall style or direction of the shading. 

Shadow 
Use the Shadow effect to emphasize text. It produces a drop-shadow 

behind the text. 

Slide Colour Scheme 

The Slide Colour Scheme option on the Format menu lets you change 

colours in a colour scheme, or select new colours for a single slide or 

an entire presentation. 

Slide Master 

The Slide Master is the slide that holds the formatting for the title, 

the text, and any background items that appear on the slides. Any 

text styles or graphics that appear on the Slide Master will appear on 

all of the slides in a presentation. 
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Slide Navigator 
The Slide Navigator allows you to go to any slide in your presentation 

while in Slide view. 

Slide Show Menu Icon 
Click the Slide Show Menu icon to open a menu with options to apply in 

Slide Show view. 

Slide Show View 
Slide Show View shows how a presentation will look when you run it. 

This allows you to do a test run and even create timed presentations. 

Slide Sorter Toolbar 

The Slide Sorter toolbar is available only in Slide Sorter view and 

allows quick access to special PowerPoint effects such as transitions, 

builds, rehearse timing, and hide slides. 

Slide Sorter View 

Slide Sorter View displays a reduced image of all the slides in a grid-

like fashion. This view makes it easier to rearrange the slides in a 

presentation and add transitions and special effects. 
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Slide View 

Slide View allows you to work on one slide at a time. While in Slide 

View, you can add any element to a slide, including text, graphics, 

shapes, and graphs. 

Slides 
Slides are the individual pages of your presentation. Slides can be 

designed with different titles, graphics, text, and much more. 

Speaker’s Notes 
Speaker’s Notes are pages with a copy of a slide on top and space 

below it for taking notes. 

Standard Toolbar 

The Standard toolbar is located beneath the menu bar and contains 

buttons that provide quick access to commonly used tools and options 

for the application. 

Status Bar 

The status bar is the area at the bottom of a window that provides 

messages that describe what you are seeing and doing in the 

presentation as you work. 
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Template 

A template is a slide or presentation that provides a predefined 

format and colour scheme that can be applied to another presentation. 

PowerPoint provides more than 100 professionally designed templates, 

or you can use an existing presentation as a template. 

Thumbnail 
A thumbnail is a small view of the current slide. It appears in several 

different PowerPoint screens, including Outline view. 

Thumbnail Prints 
Thumbnail prints are small, printed versions of slides. You can print 2, 

3, or 6 thumbnails on a single page. 

Title Case 
Title case is when each major word in the text starts with a capital 

letter. 

Title Master 
The Title Master holds the master format for title slides in a 

presentation. 
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Title Slide 
The Title slide is an Auto Layout that provides placeholders for a title 

and a subtitle for a presentation. 

Transition 
A transition is an effect that can be run between slides to signal a 

shift from one slide to the next. 

Transitions 
A transition is an effect that can be run between slides to signal a 

shift from one slide to the next. 

WordArt 

WordArt is a supplementary application that can be used to manipulate 

text into shapes. For instance, you can make a phrase or sentence 

form a circle. 

 


